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E-Mail – Communicating through Electronics!

š
Goal:

Use the E-Mail effectively and properly.

Learning Outcomes:
able to:
•
•
•

After completing this section, the student should be

Understand different parts of the Email Dialog Box
Be able to Send an Email, Open Email, Delete, Email
Attach a file to an Email. Open an attached File

Contents:
•
•
•
•
•
•
•

The Email Screen.
Creating an Email
Send, Receive and Delete an Email
Attaching a File
Open an Attachment
Hands on Email Tutorial
On your Own!

Microsoft Logos and all screens captured by permission of Microsoft

Getting On-Line
One of the main reasons people are purchasing a computer today is to get ONLINE.
This would be an opportune time for us to introduce you to the WEB. We will also be
introduced to electronic mail. E-mail alone is a good reason to get ONLINE. You can
communicate with friends, relatives, colleagues, and customers throughout the
whole world. Or you can just “surf” the Net to find any information you might need.
We will not be covering Internet in this course but we would like to introduce you to
e-mail.

WHAT IS E-MAIL?
Sending information such as a message, file etc., from one computer to another is
Electronic Mail. This term has been shorted to E-Mail. If you are connected to the
Internet, you will be able to access your mail through your server. You then need a
software package to send your e-mail. There are many programs on the market; we are
using Netscape mail in this booklet. Any of the packages will give you the basic email
protocol.
When you want to get your mail, you first have to On Line. Let’s look at some of the
terminology and although we are using different email packages, we will begin, by
having a look at the e-mail package that comes with Netscape.
Once again, when you want to use the network, you need a software package. There
are number of packages on the market. Since the different campuses are using different
software packages for Email, we will try and cover each:
•

Netscape Navigator.

•

Pegasus Mail: and

•

Web Mail

•

Getting Started With Netscape Communicator Messenger
The following instructions should help you when using an Internet server mail
service. First open Netscape Navigator. In the lower right hand corner (OR
floating) the following toolbar should appear:
Mailbox (click here to open your email program)

Floating Tool Bar.
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Determining If New Messages Have Arrived
The Mailbox button on the component bar can alert you that new messages have arrived
on your server.
Netscape Messenger checks your server periodically. After finding new messages, the
Mailbox button displays a small arrow beside the letter.

Using the New Message Window
Use the New Message Window to address, compose, and send email messages. The
New Message Window contains the following tools:

Messenger Toolbar has the following buttons:
SEND

QUOTE

ADDRESS ATTACH SPELLING

SAVE

SECURITY

STOP

What each button does:
Send

Forwards your E-mail to your ISP and then to the address

Quote

While you are composing a reply in a New Message Window, you
can include text from the original message.

Address

is to create or edit the address list.

Attachments is to attach files to your message by using drag and drop.
Save

Saves your composition for future sending.

Security

can show you encrypting message information

Compose and send messages.
You can send a message using any of the following methods:
Use a New Message Window to create and send a new message
OR
Reply. to a Message
SSFC
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To create a New Message, open the File menu and choose New Message.

To Reply to a message: when you are displaying a message that you received,
click Reply on the toolbar and choose from the Reply menu.

Sending and Receiving Messages
To send your
message
click here

Address of
the person
your sending
to goes here
Type in a
brief subject
title here.

This is the
area where
you type your
message

Recipient Types and What They Mean
An address in an address list can have one of the following recipient types:
To
CC
BCC

SSFC

Primary recipients of your message.
Carbon Copy, for secondary recipients.
Blind Carbon Copy, for secondary recipients not identified
to the other recipients, including those in the CC list.
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?

Time for you to try!

Be sure to log onto the Network
•

Click on Start

•

Click on Netscape Navigator

•

Click on the Mail icon

•

Click on New Message

•

In the To: box type: yourlogin@flemingc.on.ca

•

In the Subject: box type: Trying to send an email

•

In the Message box type the following message:
This message is to test my email. If I succeed, I will send another
message soon.
Sign your name.

•

Click SEND.

Give it a few minutes, and then check if your email message came to you.

This is what you’ll see when you receive E-mail
Depending upon the layout of your screen, you should see a list of messages.
For consistency, we will set up your view to look like the example used in below.
To do this:
ü
Click on View on the menu
ü

SSFC

Click on Show. A sub menu will appear
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Make sure there is a check mark beside only the items
ü
üMessage Toolbar
ü
ü

üMessage

and

üFolders.
If a checkmark is NOT there, click on the item, this will
put a checkmark beside it.

To receive your Email – click here –
Get message

The emails you
have received will
be listed here.
You will need to
click on one.

Their letter to you
is here.

You will need to click on an email message in the information area; the contents
of the email will show in the letter area.
How To Save E-mail Addresses in Netscape Messenger
Messages that you receive will stay in the INBOX until you delete them. At this
point, that will be enough for our exercises. Once you get involved in email, it will
be important for you to create folders to save important messages.
About the Address Book
Use an address book to store and maintain information about individuals and to
create mailing lists and nicknames.
After creating entries in an address book, you can use address book entries to
look up information about your personal contacts, such as email addresses and
phone numbers. You can also access system-wide address books if they are
available at your location.
SSFC
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Use the Address Book window to create, store, and edit address book entries. An
address book entry stores names, postal addresses, email addresses, phone
numbers, and other information about an individual, such as whether the
recipient prefers plain text or rich-text messages.

Click on Message
Then
Click on Add to
Address Book
Then
Click on Sender
Click on to highlight
the address you
want to save

A dialog box will appear. This is where you edit the information of the person who
sent you the email. Netscape Messenger will automatically insert the email
address and the person’s name as provided and shown in the email, however
you may wish to edit or add to this information in the areas as provided below.
Hint: be sure to check that the person sending you the email is using their email
address and not someone else’s.
Most common error in returning E-mail to the sender is that they have used
someone else’s computer to do so. Caution: be aware that you could be sending
your E-mail to someone you really don’t want to. It’s always a good idea to
confirm ones home computer address and E-mail before your send any personal
information.

SSFC
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Pegasus
Pegasus Mail is the electronic mail system used at many of the Fleming campuses.
Pegasus Mail has been placed on the Start Menu for easy access.

THE SCREEN

Tool Bar icons
are discussed on
the next page.

1

SSFC
1

Screen Capture by permission of Microsoft (R)
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Compose a new mail message.
Open your new mail.
Open or work with any other mail folders.
Open or work with address books.
Open or work with mailing lists.
Lookup users on your local area network.
Define or work with filters.
Open the notice board system.
Cut, copy and paste using the clipboard.
Save to disk or read from disk.
Print current or selected items.
Select a font for the current window.

SENDING A MESSAGE
•

Click on New Message from the File Menu or use the Compose a new mail
message Button on the Toolbar

The following screen will be displayed:

SSFC
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The To: field is the box where you enter the recipient’s e-mail address. Your email address at Fleming is USERID@FLEMINGC.ON.CA. How you read this email address is: Your login name, the symbol for at (@), Fleming College,
Ontario, Canada.
The Subj: field should be used to enter the Subject of your message. Keep it
short!
The Cc: field is only used when you want to send a copy to someone else.
I suggest using the Confirm reading Option and for important messages, Copy
self Option. Simply click in the box in front of these options. A check mark
indicates they are active. Use urgent, when it is! Do not use this option if your
message is not extremely important. Keep in mind that it does not send your
message any faster.
In the text area, type your message. This is similar to writing a Memo. Use this
area just like a blank document and you are typing a message. This program has
basic Word Processing features built in. i.e. word wrap, spell check, etc.
When finished, click on the Send Button. Clicking on the Cancel Button will
cancel your message.

RETRIEVING MESSAGES
When you Launch Pegasus Mail, any new mail will be displayed on screen.
Pegasus Mail stores your e-mail messages for you in Folders. The folders are
automatically created for you. They are the Main Folder and New Mail Folder.

READING A MESSAGE
•

Highlight the message and press enter.

DELETING A MESSAGE
After reading the message you will probably want to delete it:
• Highlight the message and press the Delete Button.

Attachments
To send an attachment, you would click on the Attach Icon, find the file on your
computer and then attach it, and send it.
We will do this together:

SSFC
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?

Time for you to try!

We will create a memo style note, save it to our floppy disk, then create an email
and attach the memo.
•

Open Word.

•

Click on File on the menu

•

Click on New

•

Click on the tab Memos

•

Click on Elegant Memo, Click on OK

•

A document will appear

•

Click where it tells you to click beside To:

•

Click where it tells you to click beside From: type your name

•

Click where it tells you to click beside Subject

•

Click three times in the text area

type The President

type – learning email

Type a short message saying:

This is a memo to remind everyone to use email. It is an efficient
way to communicate within the office and to outside contacts.
•

We need to save this memo. Click on File, Save As. In the SAVE IN
location, Click on the drop down and choose 3 ½ “ Floppy A:

•

In the file name box type Email memo

•

Now we are ready to create the email and attach this file.

•

Open your email program

•

Click on New Message or Compose new message icon.

•

In the TO: location, type in your own email address

•

In the subject line, type in sending an attachment.

•

Click on the attachment tab

•

or in Netscape, the attach button on
the tool bar. It usually resembles a
paper clip.

SSFC
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You will be presented with a dialog box, OR a menu asks you what you
want to attach. You will designate a file.
Remember we saved the file
on the floppy drive. So, LOOK
IN. the floppy
Then double click on the Email
memo file we saved. This
should attach the file for you.

•

Click back to the Edit tab. In the message area, type a small message
saying: -- I have enclosed a memo for you.

•

Click Send.

•

You should receive the email in a few minutes.

•

Once you have received the email, you will need to take the
attachment off. The easiest way is to right click on the file attachment
and then choose Save As... (or in Pegasus click on the button Save)

•

Save the file to the DESKTOP! Always look WHERE you are saving.
Otherwise you will have saved the file, but won’t be able to find it!

?

Time for you to try!

Final Project:
In this project you will create a memo document in Notepad, Save it, then
attach it to an email to your instructor. Let’s begin.
•

Open Word.

•

Click on File on the menu

•

Click on New

•

Click on the tab Memos

•

Click on Elegant Memo

•

A document will appear

SSFC
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•

Click where it tells you to click beside To:

•

Click where it tells you to click beside From:

type your name

•

Click where it tells you to click beside Subject
attachment.

type – sending an

•

Click three times in the text area

type Your Instructor’s name

Type a short message saying:

This is a memo showing you how I have learned to:
Create a Memo using Microsoft Word
Create an Email
Attach a document to an Email.
•

Save this memo. Click on File, Save As. In the SAVE IN location, Click
on the drop down and choose Desktop

•

In the file name box type Memo to Teacher

•

Now we are ready to create the email and attach this file.

•

Open your email program

•

Click on New Message or Compose new message icon.

•

In the TO: location, type in your instructor’s email address. You may
need to look it up in the faculty address book.

•

In the subject line, type in Assignment in Email.

•

Click on the attachment tab

•

or in Netscape, the attach button on
the tool bar. It usually resembles a
paper clip.

•

You will be presented with a dialog
box, OR a menu, asking you what you want to attach. You will
designate a file.

•

Remember we saved the file on the Desktop. So, LOOK IN. Desktop

•

Then double click on the Memo to Teacher file we saved. This should
attach the file for you.

SSFC
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•

Click back to the Edit tab. In the message area, type a small message
explaining that you have finished this module and this is the
assignment, which you had to attach.

•

Click Send.

CCongratulations! You are
done!

SSFC

- 13 -

D. Berlenbach

